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Read This First

About This Manual

This user’s guide describes the operation of the Texas Instruments CodecControl software for the
PCM9211EVM. CodecControl provides a graphical user interface (GUI) for supported TI audio codecs.
The software is compatible with Microsoft® Windows® XP, Vista, and Windows 7.

For a more detailed description of the PCM9211 product line, refer to the product data sheet available
from the Texas Instruments web site at http://www.ti.com/. Support documents are listed in the section of
this guide entitled Related Documentation from Texas Instruments.

How to Use This Manual

Throughout this document, the abbreviation EVM and the term evaluation module are synonymous with
the PCM9211EVM.

Chapter 1 discusses the block diagram and primary features of the PCM9211EVM. This chapter also
provides general information regarding the default switch and jumper configurations.

Chapter 2 explains how to use the CodecControl software provided with the PCM9211EVM.

Chapter 3 includes the EVM electrical schematics and the bill of materials.

Information About Cautions and Warnings

This document contains caution statements.

CAUTION

This is an example of a caution statement. A caution statement describes a
situation that could potentially damage your software or equipment.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.

Microsoft, Windows are registered trademarks of Microsoft Corporation.
I2C is a trademark of NXP Semiconductors.
TOSLINK is a trademark of Toshiba Inc.
All other trademarks are the property of their respective owners.
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Related Documentation from Texas Instruments

The following document provides information regarding Texas Instruments integrated circuits used in the
assembly of the PCM9211EVM. These documents are available from the TI web site. The last character
of the literature number corresponds to the document revision that is current at the time of the writing of
this document. Newer revisions may be available from the TI web site at http://www.ti.com/ or call the
Texas Instruments Literature Response Center at (800) 477–8924 or the Product Information Center at
(972) 644–5580. When ordering, identify the document(s) by both title and literature number.

Data Sheet Literature Number

PCM9211 SBAS495

TAS1020B SLES025A

If You Need Assistance

If you have questions regarding either the use of this evaluation module or the information contained in the
accompanying documentation, please contact the Texas Instruments Product Information Center at (972)
644–5580 or visit the TI web site at www.ti.com.

FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense is required to
take whatever measures may be required to correct this interference.
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Description

The PCM9211EVM is an evaluation board for the PCM9211, a 216-kHz digital audio interface transceiver
(DIX) with stereo analog-to-digital conversion and routing. This EVM provides all necessary connectors
and circuitry for interfacing to audio test systems and commercial audio equipment.

1.1 Overview

The PCM9211 evaluation module is an easy-to-use, small form-factor system that allows access to all
features of the PCM9211 via a USB interface and a PC running the CodecControl software. The EVM
offers these features:

• PCM9211 device
• Optical S/PDIF input and output
• Coaxial S/PDIF input
• Analog stereo input (3.5-mm audio jack)
• Headers for GPIO and digital audio signal access
• Digital audio MUX (controlled via I2C™)
• USB interface
• User interface:

– LEDs
– Buttons

• Control interface test points
• Digital audio interface test points

1.2 Electrostatic Discharge Warning

Many of the components on the PCM9211EVM are susceptible to damage by electrostatic discharge
(ESD). Customers are advised to observe proper ESD handling precautions when unpacking and handling
the EVM, including the use of a grounded wrist strap at an approved ESD workstation.

CAUTION

Failure to observe ESD handling procedures may result in damage to EVM
components.
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1.3 Getting Started

To get started with the PCM9211EVM, perform the following steps:

Step 1. Install the CodecControl software (see Chapter 2)
Step 2. Launch the CodecControl software.
Step 3. Plug a digital audio source into the coaxial S/PDIF input (J5).
Step 4. Plug a analog audio source (line level) into the analog input (J2).
Step 5. Connect the EVM to the PC via a mini USB-B to USB-A cable. The CodecControl software

automatically detects the EVM and runs an initialization script, which then configures the
PCM9211EVM for audio recording through the coaxial S/PDIF input.

You can now record music with any Windows application that can record audio from a sound card.

1.4 PCM9211 Configuration and Script Examples

Signal routing configuration and input/output options as well as analog-to-digital converter (ADC)
configuration are accessible via the graphical user interface (GUI) and the accompanying device block
diagram within the software; see Figure 2-1. Refer to the PCM9211 data sheet for further details on
configuration of the PCM9211.

The PCM9211 is controlled via its register map. The active objects within the block diagram automatically
update the relevant registers; changes made to a register (for example, using a command script)
automatically update the block diagram state.

When the EVM is connected, the control software executes the initialization script and configures the
PCM9211 for a common use case.

You can develop custom scripts using a text editor and execute the scripts in the command dialog, as well
as enter scripts directly in the command dialog for execution.

The control software comes with several script examples, including:

• ADC record via MainOutput to TAS1020b.txt
• PC record via TAS1020 through MPIOC in DIT output.txt
• S/PDIF record via TAS1020 through RXINx in MainOutput.txt

You can use these examples as starting points to develop your own custom scripts for the PCM9211.

1.5 EVM Applications

An EVM application is a set of scripts that configure the PCM9211EVM for one or more specific use
cases. For example, an application might consist of one script for S/PDIF recording and another set of
scripts (or patches) to change the EVM S/PDIF MUX for RXINx.

Another simple technique is to use the PCM9211 initialization script from the CodecControl software as
the first application. With this application, the EVM acts as a coax S/PDIF to USB interface without
requiring the CodecControl software.

The PCM9211EVM supports multiple EVM applications that can be stored in the onboard EEPROM.

SW2 cycles through applications. LED D1 indicates the active application blinking N times when SW1
selects application #N.

SW3 cycles through patches. LED D2 indicates the patch (or patches) applied by blinking N times when
SW2 selects patch #N

The first application (if present) is the boot application. The boot application contains a script that is
intended to initialize the PCM9211. Press SW1 to skip the boot application.

The first script of each application contains the application itself. Subsequent scripts of each application
(other than the boot application) are loaded as patches to the application each time SW2 selects a patch.

It is possible to program complex use cases to the EVM and execute them without having to run the
CodecControl software.
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1.6 Jumpers, Connectors, Test Points, Switches

Table 1-1 summarizes the connectors, test points, jumpers, and switches on the PCM9211EVM.

Table 1-1. PCM9211EVM Jumpers, Connectors, Test Points, Switches

Connector/Switch/Jumper/Test
Point Description

Headers

W1 VCCAD wire loop. Cut and insert ampere meter to measure VCCAD
current.

W2 Right channel analog RC filter bypass. Insert shunt to bypass the
filter.

W3 Right channel analog RC filter bypass. Insert shunt to bypass the
filter.

W4 VCC wire loop. Cut and insert ampere meter to measure VCC current.

W5 VDDRX wire loop. Cut and insert ampere meter to measure VDDRX
current.

W6 Control interface MODE select. Insert shunt to select I2C™ interface.
Remove shunt to select SPI interface.

W7 DVDD wire loop. Cut and insert ampere meter to measure DVDD
current.

W8 Optical S/PDIF output select. 1-2: Select MPO0, 2-3: Select MPO1.

W9 Digital audio interface option. Insert shunt to connect the
PCM9211digital audio interface output to the TAS1020b digital audio
interface (required to record audio).

W10 Coaxial S/PDIF input select:1-2: Select RXIN0, 2-3: Select RXIN1

W11 11-pin header to access RXIN2:7 and digital audio interface (AxxxIO).

W12 (1) SPI SS / ADR1: 1-2: ADR1 = 0 (I2C), 2-3: SPI mode select

W13 (1) Control IF clock: 1-2: I2C mode select, 2-3: SPI mode select

W14 (1) Control IF data: 1-2: I2C mode select, 2-3: SPI mode select

W15 (1) Control IF data: 1-2: ADR0 = 0 (I2C), 2-3: SPI mode select

Test Points

TP1 I2C SCL

TP2 I2C SDA

TP3 TAS1020b MCLK

TP4 TAS1020b I2S DIN to codec

TP5 I2S BCLK

TP6 TAS1020b I2S DOUT from codec

TP7 TAS1020b I2S WCLK

TP8 SPI MISO

TP9 SPI MOSI

TP10 SPI SS

TP11 SPI SCLK

TP12 Codec reset

TP13 XTI

TP14 Control interface MODE

TP15 +5-V USB

TP16 +3.3 V

TP17 GND

TP18 GND
(1) All W12-W15 settings must be the same for proper operation.
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Table 1-1. PCM9211EVM Jumpers, Connectors, Test Points, Switches
(continued)

Connector/Switch/Jumper/Test
Point Description

Jumpers

J1 Mini USB-B connector

J2 Analog audio input

J3 Optical S/PDIF output

J4 Optical S/PDIF input

J5 Coaxial S/PDIF input

Switches

SW1 Reset codec

SW2 Select EVM application

SW3 Select patch script

LEDs

D1 EVM application indicator

D2 EVM patch indicator

D4 PCM9211 ERROR indicator

D5 PCM9211 PCM indicator

Connectors

P3 Odd: GND

P3.2 ERROR/INT0

P3.4 PCM/INT1

P4 Even: MPIO_A
Odd: GND

P5 Even: MPIO_C
Odd: GND

P6 Even: MPIO_B
Odd: GND

P7 Even: GND

P7.1 SCKO

P7.3 BCK

P7.5 LRCK

P7.7 DOUT
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CodecControl Software

The CodecControl software is intended to facilitate user evaluation of TI audio codecs. It includes a script
interpreter, an interactive device block diagram-based GUI, a register inspector, and supplemental
features depending on the specific codec capabilities.

This chapter explains how to use the CodecControl software together with a TI audio codec EVM.

2.1 Control Software

The CodecControl software exposes most of the features of a supported TI audio codec EVM through an
intuitive graphical user interface.

NOTE: Before a PC running Windows can use the TI audio converter EVM as a sound card, the
EVM must be properly configured (sampling rate, audio routing, internal amplifier settings,
etc.) with the CodecControl software. This configuration occurs automatically once an EVM is
detected by the CodecControl software.

2.2 Installation

Download the CodecControl software from the PCM9211EVM audio codec product folder and launch the
program. The file is a self-extracting archive that is downloaded in a compressed format.

The default target folder is:
C:\Program Files\Texas Instruments\CodecControl

Click the Unzip button to complete the installation. The CodecControl software is now available in the
target folder. The name of the executable is CodecControl.exe.

To launch the CodecControl software, navigate to the target folder and double-click the CodecControl.exe
file.

2.3 Concepts

The CodecControl software presents a block diagram view of a supported TI audio codec EVM, such as
that shown in Figure 2-1.

The block diagram consists of active objects that respond to user input (for example, switches or
amplifiers with variable gain that show a volume control when a user clicks on the component with a
mouse).

NOTE: Active Objects: Each active object changes color to red if the cursor is placed over the
object. Clicking the object triggers its function.

Some active objects are linked to control register(s) of the particular TI audio codec. The CodecControl
software updates the appropriate register(s) whenever an active object is triggered. If a register that is
linked to an active object is changed through other components (for example, the script interpreter or the
register inspector), the active object changes its state accordingly.

The CodecControl software automatically detects a supported TI audio codec EVM once it is connected to
an available USB port of the PC.

11SBAU174–June 2010 CodecControl Software
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If no TI audio codec EVM is connected to the PC, the control software also supports an EVM simulation
mode, where it is possible to retrieve script commands based on user input within the block diagram.

Simulation mode is only available if no TI audio codec EVM is attached to the PC. Choose File->New
EVM simulation… and select an EVM from the list of supported TI audio codec EVMs.

2.4 EVM Window

Figure 2-1 illustrates the PCM9211EVM window as an example of the CodecControl software in operation.

Figure 2-1. EVM Window

At the top of the EVM window is a toolbar with a zoom box and a box that enables all active objects in the
block diagram.

The toolbar contains a control that determines the zoom factor. Change the zoom by selecting the desired
zoom factor.

To move the block diagram, click on a blank area within the block diagram and drag the diagram with the
mouse.

At the bottom of the EVM window, a status bar that provides information about the state of the
communication between the control software and the TI audio codec EVM. It also shows hints about
elements in the block diagram; for example, the I2C page and register/bit location of a selected switch.

Audio signal paths (both digital and analog) change colors once they are routed via switches. This feature
visualizes all audio paths and immediately highlights a path if it is enabled.
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2.4.1 Using Active Objects

Moving the mouse pointer over an active object highlights the active object; as noted, the object turns red.

For example, the MPIO_A active object changes from its inactive state to its active state when the mouse
pointer enters the amplifier symbol, as Figure 2-2 shows.

Figure 2-2. MPIO_A Active Object Changes from Inactive to Active State

Clicking the activated object triggers its function, as shown in Figure 2-3. In the case of the MPIO_A active
object, the function is a dialog box with options to configure the MPIO_A of the PCM9211.The
CodecControl software updates the appropriate register in the TI audio codec.

Figure 2-3. MPIO_A Active Object Function Pop-Up Window

13SBAU174–June 2010 CodecControl Software
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2.5 Dialogs and Active Objects

The CodecControl software contains several dialog windows that provide access to additional features.
Most dialogs are linked to active objects and are opened by clicking on the active object.

Several dialogs are not linked to active objects and are opened instead using the View menu.

2.5.1 Command Dialog

Open the command dialog (View->Command…) to write, edit, load, save, and run command scripts.
Command scripts are text files that contain commands to communicate with the TI audio codec. The
syntax is described in Section 2.5.4. The command dialog is shown in Figure 2-4.

Figure 2-4. Command Dialog

• The primary area of the command dialog is the command buffer (editable text) which contains the
command script. To run the command script, click the Run button

• The smaller, read-only text area on the right side of the command dialog displays control data read
from the TI audio codec. The Clear button clears the Read Data field.

• The one-line text edit field on the left bottom allows single command execution.
• The Record check box enables recording of commands generated by the control software.

2.5.2 Init Script Dialog

The CodecControl software executes an initialization script when a supported TI audio codec is detected.

To show or edit the initialization script, choose View->Init Script… from the main window menu bar.

Click the Run button to run the script again.
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2.5.3 Register Inspector

The register inspector dialog (View->Register Inspector…) gives access to all registers of the TI audio
codec. Figure 2-5 illustrates the register inspector dialog.

Figure 2-5. Register Inspector

The register inspector displays the content of the connected TI audio codec device registers. To trigger
reading the content of one page, click the Refresh button.

• The addr column shows the address of the registers in decimal notation.
• The description column contains a description for each register. If the register has no function

assigned, it is declared Reserved.
• The data columns show the data of each register (one byte). The first data column uses decimal

notation, and the second uses hexadecimal notation. It is possible to change the register value by
clicking into one of the data fields and typing the new value (either decimal or hexadecimal).

• The numbered columns show the register content in binary notation. Read/write bits are shown solid
black or red; read-only bits are gray or dark red. Red numbers represent bits that recently changed. To
change a single writable bit, click on the bit and it will flip.

The coefficients may be used for a specific customer filter implementation. The format is compatible with
the TI audio codec that was detected by the CodecControl software.

2.5.4 Script Syntax

A script is a text file that contains data to send to a device.

Each line in a script file is one command. No provision is made for extending lines beyond one line, except
for the > command. A line is terminated by a carriage return.

The first character of a line is the command. Commands are:
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r Read from the serial control bus
w Write to the serial control bus
> Extend repeated write commands
# Comment
I Set interface bus to use
b Break
d Delay
f Wait for Flag

Command: r <address> <register> <length>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.
<length> is the number of bytes that will be read from <register> in auto-increment mode.
The result will be displayed in the right-side output window of the command interpreter dialog.

Command: w <address> <register> <data ...>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be written to.
<data…> is a sequence of bytes that will be written to the <register> in auto-increment mode. Each
byte is in hexadecimal format.

Command: > <data ...>
This command continues a write sequence in a new line.
<data…> is a sequence of bytes that will be written in auto-increment mode. Each byte is in
hexadecimal format.

Command: # [optional comment]
This command indicates a comment.

Command: I<interface>
<interface> is i2c for I2C or spi for SPI

Command: b[optional comment]
[optional comment] is a string of characters. The command interpreter will show a modal dialog with
the optional comment. Script execution will resume once the dialog is closed.

Command: d<time>
This command suspends script execution by at least <time> milliseconds.

Command: f <address> <register> <mask> [optional timeout]
This commands suspends script execution until the value read from <address> <register> matches
<mask>
<address> is the device address in hexadecimal format. For example, 30 for device address 0x30.
<register> is the register in hexadecimal format that will be read from.
<mask> is a 8-bit binary format mask that is compared with the data from the device. Each bit can be
0, 1, or X.
For example: <mask> = 010XX01X tests, if the data from the device has D7 = 0, D6 = 1, D5 = 0, D4 =
don’t care, D3 = don’t care, D2 = 0, D1 = 1, D0 = don’t care.
[optional timeout] specifies how long (milliseconds) the command interpreter will poll the device if the
data do not match the <mask>

16 CodecControl Software SBAU174–June 2010
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2.6 EVM Applications

The PCM9211EVM contains an EEPROM that can store EVM applications; for example:

• Initialization scripts
• Parameter patch scripts

The CodecControl software also contains a browser to access the applications stored in the EEPROM. To
access the browser, select File->EVM Applications…. Figure 2-6 illustrates the EVM Applications window.

Figure 2-6. EVM Applications

Applications stored in the EEPROM are shown in a tree view.

To add an application, choose Add Application from the context menu (right-mouse click within the tree
view).

To change the name of an application, select the application, single-click on the application, then type the
new name.

Each application owns one or several scripts. The scripts consist of a sequence of commands that
program the TI audio codec (or EVM components).

To add a script to an application, choose Add Script from the context menu. Double-click on the script to
open a command window. The command window has an Open button to choose a script via a file dialog.
Alternatively, it is also possible to write the script within the command window.
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Some TI audio codecs have on or more pushbuttons that select an application or a script within an
application. Click the Update EVM button to program the EEPROM.

Scripts are stored in a compiled binary format on the EEPROM and cannot be read back. A red lock next
to the application name highlights scripts that reside in the EEPROM but cannot be viewed in the
command window.

To change the sequence of scripts or applications, drag a script or application to the new, desired position.

2.7 Firmware update

TI may publish new firmware for TI audio codec EVMs. To program the new firmware to a TI audio codec
EVM, choose File->Update Firmware… and select the new firmware file.

The update process takes a few seconds (there is no progress bar) and is completed once the update
firmware dialog disappears. The EVM must be disconnected and reconnected to finish the firmware
update process.

18 CodecControl Software SBAU174–June 2010
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Schematic and Bill of Materials

This chapter provides the electrical and physical layout information for the PCM9211EVM. The bill of
materials (BOM) is included for component and manufacturer reference.

3.1 Schematic

The PCM9211EVM schematic is appended to this document.

3.2 Component List

Table 3-1 lists the bill of materials for the PCM9211EVM.

Table 3-1. Bill of Materials

Manufacturer Vendor
Item RefDes Count Part No Description Part No Vendor Manufacturer

192kHz DIG audio interface receiver Texas1 U4 1 PCM9211PT PCM9211PT Texas Instrumentsw/stereo ADC LQFP48-PT ROHS Instruments

USB Streaming controller2 U1 1 TAS1020BPFB 296-13041-5 Digi-Key Texas InstrumentsTQFP48-PFB ROHS

Single bus buffer gate with 3-state3 U3 1 SN74LVC1G126DBVR 296-11605-1 Digi-Key Texas Instrumentsoutput SOT23-DBV5 ROHS

Volt reg 3.3V 400mA LDO Capacitor,4 U16 1 TPS73633DBVT 296-15819-1 Digi-Key Texas Instrumentsfree NMOS SOT23-DBV5 ROHS

Remote 8-Bit I/O Expander for I2C bus5 U9 1 PCF8574APWR 296-13107-1 Digi-Key Texas Instruments
TSSOP20-PW ROHS

Dual bus buffer gate 3-STATE6 U7 1 SN74LVC2G125DCTR 296-12164-1 Digi-Key Texas InstrumentsOUTPUTS SSOP8-DCT ROHS

Single inverter gate SOT23-DBV57 U5,U6 2 SN74LVC1G04DBVR 296-11599-1 Digi-Key Texas InstrumentsROHS

Octal buffer/Driver 3-state outputs8 U8 1 SN74LVC244APWR 296-1230-1 Digi-Key Texas InstrumentsTSSOP20-PW ROHS

U10,
U11,
U12, Single 2-Input Positive-and Gate9 6 SN74LVC1G08DCKR 296-11602-1 Digi-Key Texas InstrumentsU13, SC70-DCK5 ROHS
U14,
U15

512k I2C serial EEPROM SOIC8-SM10 U2 1 24FC512-I/SM 24FC512-I/SM Digi-Key Microchip
ROHS

TOSLINK™ Transmitter 3.3V 15MB11 J3 1 TOTX147PL 05M1615 NEWARK Toshibashutter ROHS

TOSLINK Receiver 3.3V 15MB shutter12 J4 1 TORX147PL(F,T) TORX147PLFT Digi-Key ToshibaROHS

D1, D2,13 4 SML-LXT0805YW-TR LED, YELLOW 2.0V SMD0805 ROHS 67-1554-1 Digi-Key Lumex OptoD4, D5

SIT8002AI-13-33E- Oscillator SMT 6MHz 3.3V Out-enable 788-8002AI133E-14 Y1 1 MOUSER Sitime6.00000T ROHS 6.0T

Crystal SMT-ABM10 24.576MHz 4-pin15 Y2 1 ABM10-24.576MHZ-E20-T 535-9094-1 Digi-Key Abracon10PFD fundamental ROHS

Capacitor, SMD0603 cerm 47PFD 50V16 C4, C5 2 ECJ-1VC1H470J PCC470ACVCT Digi-Key Panasonic5% NPO ROHS

Capacitor, SMD0603 cerm 1.0UFD17 C7 1 C1608X7R1C105K 445-1604-1 Digi-Key TDK16V 5% X7R ROHS
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Table 3-1. Bill of Materials (continued)

Manufacturer Vendor
Item RefDes Count Part No Description Part No Vendor Manufacturer

C3, C6,
C8, C9,

C10,
C11,
C23, Capacitor, SMD0402 cerm 0.1UFD18 C27, 13 C1005X5R0J104K 445-1266-1 Digi-Key TDK Corp6.3V 10% X5R ROHSC28,
C29,
C30,
C31,
C32

C12,
C13,
C14,
C19,
C20,
C21,
C22,
C24, Capacitor, SMD0603 cerm 0.1UFD19 16 C1608X7R1H104K 445-1314-1 Digi-Key TDKC25, 50V 10% X7R ROHS
C26,
C33,
C34,
C38,
C43,
C45,
C47

Capacitor, SMD0805 cerm 10UFD20 C48 1 GRM21BR61C106KE15L 490-3886-1 Digi-Key Murata16V 10% X5R ROHS

C35,
C39, Capacitor, SMD0603 cerm 10UFD21 4 ECJ-1VB0J106M PCC2395CT Digi-Key PanasonicC42, 6.3V 20% X5R ROHS
C44

C36, Capacitor, SMD0603 cerm 10PFD22 2 GRM1885C2A100RA01D 490-3279-1 Digi-Key MurataC37 100V 10% C0G ROHS

81-Capacitor, SMD0805 cerm 4700PFD23 C41 1 GRM2165C1H472GA01D GRM2165C1H472 MOUSER Murata50V 2% C0G ROHS GA01

Capacitor, SMD1206 cerm 0.068UFD24 C40 1 GRM31C5C1E683JA01L 490-1766-1 Digi-Key Murata25V C0G 5% ROHS

Capacitor, SMD0603 cerm 1000PFD25 C1 1 C1608C0G1H102J 445-1293-1 Digi-Key TDK Corp.50V 5% C0OG ROHS

Capacitor, SMD0805 cerm 100PFD26 C2 1 GRM2165C1H101JA01D 490-1615-1 Digi-Key Murata50V 5% C0G ROHS

C15, Capacitor, alum-elect SMD-AVE TYPE27 2 AVE106M16A12T-F 338-1793-1 Digi-Key Cornell DubilierC16 A 10UFD 16V 20% ROHS

Capacitor, alum-elect SMD-VSC28 C46 1 EEE-1AA101WR PCE3867DKR Digi-Key Panasonic100UFD 10V 20% ROHS

Resistor SMD0603 1.50lΩ 1% thick29 R2 1 ERJ-3EKF1501V P1.50KHCT Digi-Key Panasonicfilm 1/10W ROHS

Resistor SMD0603 100lΩ 1% thick film30 R5 1 ERJ-3EKF1003V P100KHCT Digi-Key Panasonic1/10W ROHS

R10,
R11,
R12,
R13,
R14, Resistor SMD0603 10kΩ 5% 1/10W31 R15, 11 ERJ-3GEYJ103V P10KGCT Digi-Key PanasonicROHSR18,
R19,
R23,
R24,
R25

Resistor SMD0603 thick film 649Ω 1%32 R6, R7 2 RC0603FR-07649RL 311-649HRCT Digi-Key Yageo1/10W ROHS

Resistor SMD0603 27.4Ω 1% 1/10W33 R3, R4 2 ERJ-3EKF27R4V P27.4HCT Digi-Key PanasonicROHS
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Table 3-1. Bill of Materials (continued)

Manufacturer Vendor
Item RefDes Count Part No Description Part No Vendor Manufacturer

Resistor SMD0603 2.7kΩ 5% 1/10W34 R8, R9 2 ERJ-3GEYJ272V P2.7KGCT Digi-Key PanasonicROHS

35 R22 1 ERJ-3GSYJ750 Resistor, SMT, 0603, 5%, 1/10W, 75 P75GCT Digi-Key Panasonic

RN1, Resistor ARRAY 4x SMD0603x4 10kΩ36 RN2, 3 742C083103JPTR 742C083103JPCT Digi-Key CTS5% ROHSRN3

Resistor SMD0603 0.0Ω 5% thick film37 R21 1 ERJ-3GEY0R00V P0.0GCT Digi-Key Panasonic1/10W ROHS

R16, Resistor SMD0603 332Ω 1% 1/10W38 2 CRCW0603332RFKEA 541-332HCT Digi-Key VishayR17 ROHS

Resistor SMD0603 680Ω 5% 1/10W39 R20 1 ERJ-3GEYJ681V P680GCT Digi-Key PanasonicROHS

Resistor SMD0603 3.09kΩ 1% thick40 R1 1 ERJ-3EKF3091V P3.09KHCT Digi-Key Panasonicfilm 1/10W ROHS

P4, P5, Header thru male 2x4 pin 100LS gold41 4 PBC04DAAN S2011E-04 Digi-Key SullinsP6, P7 ROHS

Header thru male 2x2 pin 100LS gold42 P3 1 PBC02DAAN S2011E-02 Digi-Key SullinsROHS

W1, W2,
W3, W4,43 8 26630201RP2 Header 2-pin, PCB 2.0mm ROHS 2663S-02 Digi-Key NorcompW5, W6,
W7, W9

W8,
W10,
W12,44 6 26630301RP2 Header 3-pin, PCB 2.0mm ROHS 2663S-03 Digi-Key NorcompW13,
W14,
W15

45 W11 1 26630601RP2 Header 6-pin, PCB 2.0mm ROHS 2663S-06 Digi-Key Norcomp

100P-JMDSS-G-1- Plug SMD 2x50 Female JMD Series46 P1, P2 2 455-1880-1 Digi-Key JSTTF(LF)(SN) 0.5mm LS gold ROHS

47 J1 1 UX60-MB-5ST Jack USB minib SMT-RA 5-pin ROHS H2959CT Digi-Key Hirose

Jack Audio mini (3.5mm ,4-Cond48 J2 1 SJ-43516-SMT CP-43516SJCT Digi-Key CUI StackPCB-RA ROHS

RCA Jack thru RA-Female black49 J5 1 RCJ-041 CP-1418 DIGI KEY CUI StackROHS

TP1,TP2,
TP3,TP4,
TP5,TP6,
TP7,TP8, Keystone50 14 5002 PC TESTPOINT, WHITE, ROHS 5002K Digi-KeyTP9,TP1 Electronics
0,TP11,T
P12,TP1
3,TP14

TP17,TP Keystone51 2 5001 PC Testpoint, black, ROHS 5001K Digi-Key18 Electronics

TP15,TP Keystone52 2 5000 PC Testpoint, red, ROHS 5000K Digi-Key16 Electronics

SW1,SW Switch, MOM, 160G SMT 4x3mm53 3 TL1015AF160QG EG4344CT Digi-Key E-Switch2,SW3 ROHS

TP1,
TP2,
TP3,
TP4,
TP5,
TP6,
TP7,54 14 810-002-SP2L001 Shunt, black AU flash 2mmLS SP2-001E Digi-Key Norcomp INC.TP8,
TP9,

TP10,
TP11,
TP12,
TP13,
TP14

C17,55 2 C0603_DNP Not installed C0603_DNP NA NAC18

21SBAU174–June 2010 Schematic and Bill of Materials

Copyright © 2010, Texas Instruments Incorporated



Component List www.ti.com

22 Schematic and Bill of Materials SBAU174–June 2010

Copyright © 2010, Texas Instruments Incorporated



DRAWN BY:

OF:SHEET:

PCB REV:

SCH REV:

FILENAME:

DATE:

EDGE #:DESIGN LEAD: EDGE #DESIGN LEAD

PAGE INFO:�� FILENAME

DATE OF

DRAWN BY

SHEET

PCB REV

SCH REV

2220191817151413

31

30

29

27

26

25

2423

32

34

35

36

37383940

21

8

4

28

16

33

42 41

12

11

10

9

7

6

5

434445

2

1

48

3

4647

1.50K
0603

R2

47pfd/50v
0603

C4

47pfd/50v
0603

C5

100K
0603

R5

1.0ufd/16V
0603

C7

0.1ufd/6.3V
0402

C6

0.1ufd/6.3V
0402

C9

0.1ufd/6.3V
0402

C8

0.1ufd/6.3V
0402

C3

Yellow

0805

D1

0.1ufd/6.3V
0402

C10

GND

GND

SCL

SDA

DOUT

WCLK

BCLK

DIN

MCLK

GND

GND
GND

GND GND GND GND GND

GND

GND

GND

GND

GND

GND

GND

GND

6MHz/3.3V
SMT-8002

Y1
1

2 3

4

mfg: SiTIME
p/n: SIT8002AI-13-33E-6.00000T

Vcc

OUT

OE

GND

GND

mfg: E-SWITCH
p/n: TL1015AF160QG

SW2

21

GND

0.1ufd/50V
0603

C13

10K
0603

R11

GND

649
0603

R6

27.4
0603

R3

27.4
0603

R4

2.7K/5%
0603

R8

2.7K/5%
0603

R9

USB MINIB

J1

1

2

3

4

5

6

7

8

9

10

11

mfg: HIROSE
p/n: H2959CT

Data-

5v

ID_NC

GND

Data+

Case

Case

Case

Case

NC

NC

512K
SOIC8-SM

mfg: MICROCHIP
p/n: 24FC512-I/SM

U2

1

2

3

4 5

6

7

8

+5V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

+3.3V

SCLK

MISO

MOSI

SS~

RESET~

mfg: E-SWITCH
p/n: TL1015AF160QG

SW1

1 2

GND

0.1ufd/50V
0603

C12

10K
0603

R10

+3.3V

GND

mfg: E-SWITCH
p/n: TL1015AF160QG

SW3

1 2

GND

0.1ufd/50V
0603

C14

10K
0603

R12

GND

+3.3V

Yellow

0805

D2

649
0603

R7

+3.3V

0.1ufd/6.3V
0402

C11

GND

+3.3V

GND

SOT23-DBV5

1

2

4

5

3

U3

SN74LVC1G126DBVR

I2S_ENABLE

10K
0603

R13

GND

White

TP2

White

TP3

White

TP4

White

TP5

White

TP6

White

TP7

White

TP1

White

TP8

White

TP9

White

TP10

White

TP11

White

TP12

R1

0603
3.09K

C1

0603
1000pfd/50V

C2

0805
100pfd/50V

GPLED2GPLED1

SPI

RESET

I2S

I2C

EEPROM

USB INPUT

GPIO1

TAS1020BPFB

RESET

GPIO2

6516981 PCM9211_USB_EVM_REVA SL

51

A

A

MAY 25, 2010

STEVE LEGGIO

USB CONTROLLER

PCM9211_USB_EVM_REVA

MCLK

I2S_ENABLE



EDGE #DESIGN LEAD

PAGE INFO:�� FILENAME

DATE OF

DRAWN BY

SHEET

PCB REV

SCH REV

DRAWN BY:

OF:SHEET:

PCB REV:

SCH REV:

FILENAME:

DATE:

EDGE #:DESIGN LEAD: EDGE #DESIGN LEAD

PAGE INFO:�� FILENAME

DATE OF

DRAWN BY

SHEET

PCB REV

SCH REV

GND
J2

LEFT

RIGHT

S
h

ie
ld

2

4

1

3

6

5 VINR

VINL

P7
1 2

3 4

5 6

7 8

TP13

White

C33

0603
0.1ufd/50V

C22

0603
0.1ufd/50V

75
R22

RES,SMT,0603

RN3

8
7

6
5

4
3

2
1

0603x4
10K

RN2 1
2

3
4

5
6

7
8

0603x4
10K

RN1 1
2

3
4

5
6

7
8

0603x4
10K

P3

43

21

R21

0603
0.0

D4
0805

Yellow

R16

0603
332

C19

0603
0.1ufd/50V

D5
0805

Yellow

R17

0603
332

C20

0603
0.1ufd/50V

GND

GND

12

W5

12 W7

GND

GND

GND

GND

GND

GND

GND

GND

GND

+3.3V

GND

GND

GND

+3.3V

GND

GND

GND

GND

C37

0603
10pfd/100V

C36

0603
10pfd/100V

C41

0805
4700pfd/50V/2%R20

0603
680

C35

0603
10ufd/6.3V

C34

0603
0.1ufd/50V

C44

0603
10ufd/6.3V

C42

0603
10ufd/6.3V

C45

0603
0.1ufd/50V

C43

0603
0.1ufd/50V

RESET~

WCLK

DOUT

BCLK

GND

W1
21

+5V

Y2

3
1

ABM10
24.576 MHz Y2

4

2
ABM10
24.576 MHzGND

GND

C40

1206
0.068ufd/25V

GND

321

W13

SCLK

SCL

W14

1 2 3 MOSI

SDA

321

W12

GND

MISO

W15

1 2 3

SS~

C25

0603
0.1ufd/50V

20

19

18

17

16

15

14

13

12

1110

9

8

7

6

5

4

3

2

1

U9

PCF8574APWR

TSSOP20-PW

SCL

SDA

C39

0603
10ufd/6.3V

C38

0603
0.1ufd/50V

12 W4

1

2

3

4 5

6

7

8

U7

SN74LVC2G125DCTR
SSOP8-DCT

GND

GND

+3.3V

MCLK

BCLK

WCLK

DIN

GND

GND

+3.3V

+3.3V

+3.3V

+3.3V+3.3V

+3.3V+3.3V

32

W8

1

R18

0603
10K

R19

0603
10K

GND

+3.3V

C21

0603
0.1ufd/50V

P4
1 2

3 4

5 6

7 8

P5
1 2

3 4

5 6

7 8

P6
1 2

3 4

5 6

7 8

1

2

3

J4

TORX147PL(F,T)

SHIELD

GND

Vcc

OUT

J5

RCA RA-F
Black

S
h

ie
ld1

2

Signal

TP14
White

SN74LVC1G04DBVR

U5

3

5 1

4

2

SOT23-DBV5

2

4

15

3

U6

SN74LVC1G04DBVR
SOT23-DBV5

GND

SN74LVC244APWR

U8
20

19

18

17

16

15

14

13

12

1110

9

8

7

6

5

4

3

2

1

TSSOP20-PW

GND

+3.3V

C24

0603
0.1ufd/50V

+3.3V

GND

GND

W10

1 2 3

C26

0603
0.1ufd/50V

+3.3V

GND

2mm PIN HEADER
W11

654321

GND

GND

GND

+3.3V

GND

+3.3V

GND

+3.3V

GND

+3.3V

U10
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

U11
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

U12
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

U13
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

U14
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

U15
1

2
4

SN74LVC1G08DCKR
SC70-DCK5

5

3

SN74LVC1G08DCKR

U10

SC70-DCK5

Vcc

GND

U11

SN74LVC1G08DCKR

3

5

SC70-DCK5

Vcc

GND

U12

SN74LVC1G08DCKR

3

5

SC70-DCK5

Vcc

GND

U13

SN74LVC1G08DCKR

3

5

SC70-DCK5

Vcc

GND

U14

SN74LVC1G08DCKR

3

5

SC70-DCK5

Vcc

GND

U15

SN74LVC1G08DCKR

3

5

SC70-DCK5

Vcc

GND

C27

0402
0.1ufd/6.3V

C28

0402
0.1ufd/6.3V

C29

0402
0.1ufd/6.3V

C30

0402
0.1ufd/6.3V

C31

0402
0.1ufd/6.3V

C32

0402
0.1ufd/6.3V

C23

0402
0.1ufd/6.3V

1

2

3

J3

TOTX147PL

VCC

INPUT

GND

SHIELD

PCM9211PT

U4
4

8

4
7

4
6

4
5

4
4

4
3

4
2

4
1

4
0

3
9

3
8

3
7

36

35

34

33

32

31

30

29

28

27

26

25

2
4

2
3

2
2

2
1

2
0

1
9

1
8

1
7

1
6

1
5

1
4

1
3

12

11

10

9

8

7

6

5

4

3

2

1

LQFP48-PT

W6

2
1

+3.3V

10K
0603

R23

GND

GND

1
2

W9

+3.3V

R24

0603
10K

GND

0603
DNP

C17

C18

DNP
0603

10K
0603

R14

10K
0603

R15

1 2
W2

1 2
W3

C15

10ufd/16V
AVE-A

+

AVE-A

10ufd/16V

C16

+

OPTICAL
MPO0-MPO1

MPIO CONNECTIONS

ERROR/NPCM
& INT

FILTER COMPONENTS
LOCATE CLOSE TO THE DEVICE UNDER TEST (DUT) U4

U4-PIN 26

U4-PIN 25

U4-PIN 24

U4-PIN 23

ANALOG LINE IN

PCM9211_USB_EVM_REVA SL

52

A

A

MAY 25, 2010

STEVE LEGGIO

AUDIO CODEC

PCM9211_USB_EVM_REVA

6516981

I2S/SPI SELECTION

COAX INPUTS 
RXIN0-RXIN1

OPTICAL INPUTS 
RXIN2-RXIN7

If C17 & C18 are placed 
as filter components,
film type capacitor 
is recomended.



DESIGN LEAD: EDGE #:

DATE:

FILENAME:

SCH REV:

PCB REV:

SHEET: OF:

DRAWN BY:

SCH REV

PCB REV

SHEET

DRAWN BY

OFDATE

FILENAME�� PAGE INFO:

DESIGN LEAD EDGE #EDGE #DESIGN LEAD

PAGE INFO:�� FILENAME

DATE OF

DRAWN BY

SHEET

PCB REV

SCH REV

0.5in

HW1

0.5in
GND GND GND GND

0.5in

HW2

0.5in

0.5in

HW3

0.5in

0.5in

HW4

0.5in

GND GND

GND GND

GND GND

GND GND

P1

100

98

96

94

92

90

88

86

84

82

80

78

76

74

72

99

97

95

93

91

89

87

85

83

81

79

77

75

73

71

mfg: JST
p/n: 100P-JMDSS-G-1-TF(LF)(SN)

SMD-0.5mm

5049

48

46

44

42

47

45

43

41

31

33

35

37

39

32

34

36

38

40

20

18

16

14

12

10

8

6

4

2

19

17

15

13

11

9

7

5

3

1

21

23

25

27

22

24

26

28

29 30

51

53

55

57

59

61

63

65

67

69

52

54

56

58

60

62

64

66

68

70

Anchor

SMD-0.5mm

GND

SMD-0.5mm

Anchor

P2

82

80

78

81

79

77

75

mfg: JST
p/n: 100P-JMDSS-G-1-TF(LF)(SN)

SMD-0.5mm

5049

48

46

44

42

47

45

43

41

31

33

35

37

39

32

34

36

38

40

20

18

16

14

12

10

8

6

4

2

19

17

15

13

11

9

7

5

3

1

21

23

25

27

22

24

26

28

29 30

76

74

72

73

71

51

53

55

57

59

61

63

65

67

69

52

54

56

58

60

62

64

66

68

70

90

88

86

84

89

87

85

83

91

93

95

97

92

94

96

98

99 100

GND

GNDGND

GND

GND

GND

GND

GND

GND

GND

GND

GNDGND

GND

GND

GND

GND

GND

GND

GND

GND

VINL

GND

GND

GND

GND

GND

GND

GND

GND

VINR
+5V +5V

GND

GND

GND

GND

GND

GND

GND

GND

+3.3V+3.3V

V_ENABLE

MCLK

GND

GND

GND

BCLK

DOUT

MISO

MOSI

GND

GND

GND GND

SDA

SCL
GND

DIN

WCLK

I2S_ENABLE

GND

GND

GND

GND

RESET~

GND

GND

MCLK

SS~

SCLK

GNDGND

TP17
Black

TP18
Black

GND

GND GNDGNDGND

C47

0603
0.1ufd/50V

C48

0805
10ufd/16V

+5V

+5V

R25

0603
10K

1

2

3 4

5
TPS73633DBVT

U16

SOT230DBV5
3.3V/400mA

V_ENABLE

GND

GND

+3.3V

TP15
Red

TP16
Red

VSC
100ufd/10V

C46
+

+5.0V   USB INPUT
+3.3V   OUTPUT

POWER SUPPLY

RESERVED

I2S_2

MCLK_2

RESET

SPI

MCLK

RESERVED

SPKGNDSPKGND

SPKVDDSPKVDD

HPVDD
HPGND

RESERVED

HPGND
HPVDD

AV_ENABLE

DIGITAL INTERFACE CONNECTOR

BREAK-OUT CONNECTIONS BREAK-OUT CONNECTIONS

AGND=GND=DGND

GND

+5VA
AGND
+3.3VA

AGND
+1.8VA
AGND

AGND
VARVA

AGND
+1.8VA
AGND

+3.3VA
AGND
+5VA

6516981

PCM9211_USB_EVM_REVA

POWER & CONNECTIONS

STEVE LEGGIO

MAY 25, 2010

A

A

3 5

SLPCM9211_USB_EVM_REVA

STANDOFFS

ANALOG INTERFACE CONNECTOR

BREAK-OUT CONNECTIONS BREAK-OUT CONNECTIONS

VARVA
AGND

LINE
OUTPUTS

OUT1GND
OUT1-

OUT2-
OUT2GND
OUT3-
OUT3GND

AGND

HEADSET
OUTPUTS

HP1L

OUT4GND
OUT4-

HP1R

HP2R
HP2L

AGND

OUT4+
OUT4GND

OUT3GND
OUT3+

OUT2GND
OUT2+

OUT1+
OUT1GND

LINE
OUTPUTS

HPGND
HPGND

HPGND
HPGND

HEADSET
GROUND

SPK1+
SPK1-
SPK2+
SPK2-

CLASS-D
SPEAKER
OUTPUT

CLASS-D
SPEAKER
OUTPUT

SPK2-
SPK2+
SPK1-
SPK1+

AGNDAGND

AGND

AGND

AGND

AGND

AGND

AGND

AGND

AGND
MICBIAS

IN2+

IN1+

IN3+

IN4+

IN5+

IN6+

IN7+

IN8+

AGND

AGND

AGND

AGND

AGND

AGND

AGND

AGND
MICDET

IN2-

IN1-

IN3-

IN4-

IN5-

IN6-

IN7-

IN8-

+5VD +5VD
DGND

DGND

DGND

DGND

DGND

DGND

DGND

DGND

+3.3VD+3.3VD

+1.8VD+1.8VD

VARVDVARVD

DV_ENABLE

RESERVED
RESERVED

I2C

MCLK

DGND

I2S

DGND

I2S_ENABLE

DGND



Evaluation Board/Kit Important Notice

Texas Instruments (TI) provides the enclosed product(s) under the following conditions:

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. Persons handling the
product(s) must have electronics training and observe good engineering practice standards. As such, the goods being provided are
not intended to be complete in terms of required design-, marketing-, and/or manufacturing-related protective considerations,
including product safety and environmental measures typically found in end products that incorporate such semiconductor
components or circuit boards. This evaluation board/kit does not fall within the scope of the European Union directives regarding
electromagnetic compatibility, restricted substances (RoHS), recycling (WEEE), FCC, CE or UL, and therefore may not meet the
technical requirements of these directives or other related directives.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30
days from the date of delivery for a full refund. THE FOREGOING WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY
SELLER TO BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE.

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all
claims arising from the handling or use of the goods. Due to the open construction of the product, it is the user’s responsibility to
take any and all appropriate precautions with regard to electrostatic discharge.

EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES.

TI currently deals with a variety of customers for products, and therefore our arrangement with the user is not exclusive.

TI assumes no liability for applications assistance, customer product design, software performance, or infringement of
patents or services described herein.

Please read the User’s Guide and, specifically, the Warnings and Restrictions notice in the User’s Guide prior to handling the
product. This notice contains important safety information about temperatures and voltages. For additional information on TI’s
environmental and/or safety programs, please contact the TI application engineer or visit www.ti.com/esh.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used.

FCC Warning

This evaluation board/kit is intended for use for ENGINEERING DEVELOPMENT, DEMONSTRATION, OR EVALUATION
PURPOSES ONLY and is not considered by TI to be a finished end-product fit for general consumer use. It generates, uses, and
can radiate radio frequency energy and has not been tested for compliance with the limits of computing devices pursuant to part 15
of FCC rules, which are designed to provide reasonable protection against radio frequency interference. Operation of this
equipment in other environments may cause interference with radio communications, in which case the user at his own expense
will be required to take whatever measures may be required to correct this interference.

EVM Warnings and Restrictions

It is important to operate this EVM within the input voltage range of 0V to +5V (USB) and the output voltage range of 0V to +5V.

Exceeding the specified input range may cause unexpected operation and/or irreversible damage to the EVM. If there are
questions concerning the input range, please contact a TI field representative prior to connecting the input power.

Applying loads outside of the specified output range may result in unintended operation and/or possible permanent damage to the
EVM. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the load
specification, please contact a TI field representative.

During normal operation, some circuit components may have case temperatures greater than +35°C. The EVM is designed to
operate properly with certain components above +35°C as long as the input and output ranges are maintained. These components
include but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors. These types of
devices can be identified using the EVM schematic located in the EVM User's Guide. When placing measurement probes near
these devices during operation, please be aware that these devices may be very warm to the touch.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2010, Texas Instruments Incorporated

http://www.ti.com/esh


IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.

TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Amplifiers amplifier.ti.com Audio www.ti.com/audio

Data Converters dataconverter.ti.com Automotive www.ti.com/automotive

DLP® Products www.dlp.com Communications and www.ti.com/communications
Telecom

DSP dsp.ti.com Computers and www.ti.com/computers
Peripherals

Clocks and Timers www.ti.com/clocks Consumer Electronics www.ti.com/consumer-apps

Interface interface.ti.com Energy www.ti.com/energy

Logic logic.ti.com Industrial www.ti.com/industrial

Power Mgmt power.ti.com Medical www.ti.com/medical

Microcontrollers microcontroller.ti.com Security www.ti.com/security

RFID www.ti-rfid.com Space, Avionics & www.ti.com/space-avionics-defense
Defense

RF/IF and ZigBee® Solutions www.ti.com/lprf Video and Imaging www.ti.com/video

Wireless www.ti.com/wireless-apps

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2010, Texas Instruments Incorporated
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